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Introduction: Welcome to Thomson Reuters 
EndNote X4

EndNote—your complete reference 
solution! 

 EndNote is an online search tool—you can search online 
bibliographic resources and retrieve references directly into 
your EndNote library. You can also export references to 
EndNote from your favorite online resource (see “Direct 
Export Providers” in EndNote Help).

 EndNote is a reference and full text organizer with a 
collaborative Web tool—your personal reference library will 
save you countless hours of organizing your research. Group 
references according to your research projects and attach up 
to 45 files for managing related materials. EndNote can 
locate full text PDF files for you or create a reference when 
importing a PDF file. Transfer references to your EndNote 
Web account to share groups with other EndNote users 
easily and manage your ResearcherID publication list. 

 EndNote is a bibliography maker—Cite While You Write™ 

takes the pain out of citing and formatting references in Apple  
Pages ‘09, Microsoft® Word, and OpenOffice.org Writer 3 for 
Windows. You can also create bibliographies for other 
presentation software using Format Papers (RTF files). 
There is simply no better tool than EndNote for handling 
diverse bibliographic style requirements.

EndNote and EndNote Web are collaborative tools to simplify 
working with colleagues.

See “What’s New in EndNote X4” on page 9 for a list of the most 
recent features added to EndNote.

For late-breaking news and updates, please go to: 
http://www.endnote.com/support.

About the Demo Version of EndNote and 
the EndNote Viewer

If you are working with the demonstration version of EndNote X4, 
you have 30 days after you first use the program to evaluate 
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EndNote and all of its features. After those 30 days, the Demo 
version will revert to a feature-restricted EndNote Viewer.

NOTE: While you can see the entire list of Microsoft Word templates 
available with the full version of EndNote, the demo version includes 
only the Nature manuscript template specifications. Any of the 
manuscript templates you choose will launch the Nature manuscript 
template.

After the program reverts to an EndNote Viewer, you still will be 
able to open EndNote libraries, search, sort, and print 
references. 

With the EndNote Viewer you will not be able to:

 Add or edit references in a library that has 10 or more 
references already in it. 

 Format more than 10 citations in a paper. 

 Retrieve more than 10 references from a remote database. 

 Import more than 10 references. 

 Export more than 10 references at one time. 

To purchase an unrestricted version of the EndNote program, 
open your trial version and click the Yes button when the 
EndNote dialog appears with the message:

     “Would you like to activate the full version of EndNote?”

You will need to purchase a Product Key in order to activate the 
unrestricted version of EndNote X4.

About this Getting Started Guide
This guide provides a basic overview of installing and using 
EndNote. It is not a complete user’s guide, but rather is intended 
as a guided tour to show you the highlights of the EndNote 
program.

This guide assumes that you know how to use your Windows 
operating system and your word processor. For help on these 
topics, consult your computer owner’s guide or your word 
processor manual. 

Often there is more than one way to select a command in 
EndNote. A single command may be available from one of the 
main menus, from a context-sensitive right-click menu, from a 
tollbar icon, or with a keyboard command. In most cases, this 
manual gives instructions for selecting commands from the main 
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menus. If a menu command has a keyboard equivalent, the 
keyboard command appears next to the menu item.

The following representations for key combinations are used:

Instruction Explanation

CTRL+ESC While holding down the CTRL key, press 
the ESC key. 

CTRL+ALT+ENTER While holding down the CTRL and ALT 
keys, press the ENTER key.

Menu names, menu selections, and button names appear in italic 
text. 

Customer Services

Register Your 
Copy of 
EndNote

If you haven’t done so already, please fax or e-mail 
your registration to Thomson Reuters (go to 
http://www.endnote.com/encontact.asp). You also have the 
opportunity to register during installation. Even if you purchased 
EndNote directly from Thomson Reuters, do not assume that you 
are registered. Registered users receive:

 free technical support

 special upgrade offers

 notification of new EndNote versions that are compatible with 
the latest version of your word processor

EndNote  
Online Help

Online Help: The online Help file is another source of 
information about EndNote. From EndNote’s Help menu, select 
Contents to view the various topics. For context-sensitive help, 
click the Help or ? button found on various windows and dialogs, 
or press the F1 key on your keyboard.

The EndNote Manual: The online Help file is made available as 
a PDF file (EndNote.PDF), and is installed in your EndNote 
folder.

Release Notes: For documentation updates and correction 
notes for this release, refer to the Readme.txt file installed in the 
EndNote folder.

Late Breaking News: For late-breaking news and updates, 
please go to: http://www.endnote.com/support.
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Customer 
Service

Contact Sales for general product information, pricing, quantity 
discounts, and referrals to dealers. 

Contact Customer Service to order new copies or upgrades of 
EndNote, to check billing/shipping status, and to register your 
software.

Sales Information
Phone: 760 722 1227 (country code is 01)(Toll Free)
Phone: 760 438 5526 (country code is 01)
Fax: 760 438 5573 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp

Customer Support (Orders, Billing, and Shipping)
Phone: 800 336 4474 (country code is 01)
Fax: 215 386 2911 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp

Technical 
Support

Contact Technical Support if you encounter problems while using 
EndNote. When you contact us, please have a clear description 
of the problem and know the version of your copy of the Windows 
system, EndNote, and your word processor. To find the EndNote 
version, start EndNote and choose About EndNote from the Help 
menu. Also have your EndNote serial number available.

For web/email or phone contact, please see:
http://www.endnote.com/encontact.asp

For hours and holiday closures, please see: 
http://scientific.thomson.com/support/techsupport/hours/

Technical support tips are also available from the EndNote Web 
site and the EndNote Discussion Forum (see the sections that 
follow in this manual).

International 
Customer and 
Technical 
Support

For customer support or technical support outside of North 
America, please visit our Web site to check for a local distributor. 

Go to http://www.endnote.com, click on Contact Us, and then 
click on International Distributors to find a local distributor. 
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The EndNote 
Web Site

The EndNote Web site (http://www.endnote.com) contains 
technical support tips, utilities for data transfer, and information 
about the latest versions of EndNote. You can learn about the 
various training options. You can also find updated styles, filters, 
connection files, and other related documents at this site. Go to 
www.endnote.com/training and look under Support and 
Services.

To easily locate incremental updates available on the Web site, 
go to the Help menu in EndNote and select EndNote Program 
Updates.

The EndNote 
Discussion 
Forum

If you wish to join an ongoing forum of EndNote users like 
yourself, go to the EndNote Web site at 
http://www.endnote.com, click on Support and Services, and 
then scroll down and click on the link to go to the EndNote 
Discussion Forum. You can browse several EndNote message 
lists, easily search for topics, and join to add messages.

Join the EndNote social network at:

 www.facebook.com/EndNote

 www.twitter.com/EndNoteNews

ADA VPAT Thomson Reuters is dedicated to developing software products 
that are usable for everyone, including those with physical 
challenges and disabilities. EndNote was designed to adhere to 
the ADA (Americans with Disabilities Act) Section 508 
accessibility standards.

Please visit our Web site at http://www.endnote.com, and click 
the Support & Services link to access the VPAT (Voluntary 
Product Accessibility Template) document that describes the 
accessibility features that address the Section 508 Standards. 
The VPAT is an informational tool developed by industry and 
government to help facilitate the understanding of compatibility 
issues under Section 508.

What’s New in EndNote X4
EndNote X4 adds these features:
 Import and create new records from PDF files. Whether you 

are importing a single file or a folder of PDF files, EndNote 
uses metadata and DOI information to create a new 
reference and attach the source PDF. Basic bibliography 
Introduction: Welcome to Thomson Reuters EndNote X4 9



information will be added automatically for most journal 
articles, conference proceedings, conference papers, and 
reports.

 Search the contents of attached PDF files.You’ll find a new 
option on the field list to search PDF files separately, or in 
combination with the reference data. 

 Modify references easily in the new Quick Edit tab on the 
main library window. Use the tabs to preview formatted 
references, search your library and online resurfaced now 
edit references–all without opening additional windows.

 Create new groups by comparing, combining or suppressing 
existing groups. The new smart groups are updated 
dynamically as your library grows.

 Transfer up to 10,000 references between the desktop and 
EndNote Web to share online groups with other EndNote 
users. Shared groups are now included when you Cite  
WhileYou Write from EndNote Web.

 Expand your library retrieval results by adding wildcards 
within search terms.

 Edit references when comparing duplicates—copy/paste and 
save changes in the side-by-side view.

Cite While You Write new features include:
 Add hyperlinks between in-text citations and the bibliography 

reference in Microsoft Word using any journal style.

 Use expanded functionality when editing citations—track 
usage and more.

  Meet the complete APA 6th style requirements including 
specific handling of references with eight or more authors, 
hyphenated first names and DOI data.

 Improved footnote handling for the Chicago Manual of Style 
and similar footnote-based bibliographic styles.

 Traveling Library enhancements recognize references when 
sharing Word documents for better collaboration.

 Get a quick citation report of references cited in a Microsoft 
Word document with a new auto-group in the EndNote 
library.

NOTE: Thomson Reuters recommends that you view our What’s New 
video at www.endnote.com/training.
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Chapter 1: Windows EndNote Installation

Before You Install EndNote 
Please read this section before you proceed with the installation. 

If you are installing the full version of EndNote (not the Demo 
version), you will need a valid EndNote product key to install the 
program. If you are upgrading from a previous version, you will 
also need your previous EndNote serial number.

Program 
Requirements

Both the full EndNote program and the EndNote Demo are 
available on CD or by downloading. If you have a CD you need a 
CD-ROM drive to install the program.

System Requirements: 
EndNote runs under the following operating systems: 

 Windows 7 (32 or 64 bit versions)

 Windows Vista (32 or 64 bit versions)

 Windows XP with at least Service Pack 3 installed

Hardware Requirements:
 A personal computer with a Pentium (or compatible) 

450-MHz or faster processor

 A minimum of 256 MB of available RAM

 A hard drive with at least 180 MB of free space

 An Internet connection is required in order to use the 
EndNote Online Search feature for searching online 
databases, the Find Full Text feature, or EndNote Web. To 
use the Open Link command to access a Web site, you also 
need a Web browser installed. 

 Unicode compliant

 Handhelp compatibility—16 MB RAM

- Windows Mobile® 5x device; Serial /USB Active Synce

NOTE: Make sure that your computer meets the system and hardware 
requirements before continuing. If necessary, contact the distributor, 
dealer, or store where you purchased EndNote to arrange for a full 
refund. If you have any problem obtaining a refund, contact Thomson 
Reuters directly. You must do so within 30 days of purchase. 
Chapter 1: Windows EndNote Installation 11



NOTE: For Windows, check www.endnote.com/enwin.asp for the latest 
compatibility requiremenets.

Word 
Processor 
Compatibility

As of June 2010, EndNote for Windows is compatible with: 

 Microsoft Office Word 2003, 2007, or 2010 (32 bit version) for 
Windows

 Open Document Format (ODT) documents created with 
OpenOffice.org Writer 3

 RTF files created with most word processors, including: 
Microsoft Word, WordPerfect, OpenOffice.org Writer, 
StarOffice, and WordPad

Microsoft Word
EndNote installs Cite While You Write commands in Microsoft 
Word. Word 2003 displays an EndNote submenu of commands 
on Word’s Tools menu. Word 2007 and 2010 displays Cite While 
You Write commands on an EndNote tab. Cite While You Write 
allows EndNote to format citations and create a bibliography for 
the document that is open in Word. You can format, unformat, 
and reformat a document—without exiting your word processor.

In order for Cite While You Write to install properly, Microsoft 
Word 2003, 2007, and 2010 must be correctly installed on your 
computer prior to installing EndNote. Please make sure that you 
close Word and all applications before attempting to install Cite 
While You Write.

If a supported version of Microsoft Word is installed on your 
computer, the appropriate Cite While You Write files are installed 
automatically for the current user when you run the EndNote 
installation. This feature can be used with a shared copy of Word 
or on a network. 

OpenOffice.org Writer
EndNote installs Cite While You Write commands in the 
OpenOffice.org version 3 Writer. CWYW commands appear on 
an EndNote menu. Cite While You Write allows EndNote to 
format citations and create a bibliography for the document that 
is open in OpenOffice.org Writer. You can format, unformat, and 
reformat a document—without exiting your word processor.
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In order for Cite While You Write to install properly, the 
OpenOffice.org 3.x suite must be correctly installed on your 
computer prior to installing EndNote.

You must close all OpenOffice.org applications before installing 
Cite While You Write, including the OpenOffice.org Quickstarter. 

RTF and ODT Documents
For word processors other than Word 2003, Word 2007, Word 
2010, or OpenOffice.org 3.x, first write your paper and insert in-
text citations. If the file format is anything other than an 
OpenOffice.org ODT document, save as an RTF file. Then, use 
EndNote’s Format Paper feature to format the citations and 
bibliography from your ODT or RTF file.

EndNote Installation
Follow these instructions to install the EndNote program. 

If you are upgrading from a previous version of EndNote, please 
see “Upgrading from an Earlier EndNote Version” on page 19.

See “Networks and Volumne Installations” in EndNote help for 
information about using EndNote in a network environment, 
licensing, and performing mass installations.

Installing 
EndNote

To install EndNote:
1. Log in to the local machine with administrative rights or as a 

user with program installation privileges. Make sure no 
applications are running, including virus protection software, 
Microsoft Word, or any OpenOffice.org applications. 

The OpenOffice.org Quickstarter may appear in your System 
tray. Right click on the icon and choose Exit Quickstarter.

2. Start the EndNote installation program.

If you downloaded the EndNote installer: Double click the 
installer file to start the EndNote Setup program. 

If you received EndNote on a CD: Insert the CD into your 
CD-ROM drive. 

The EndNote Setup program will start. If you do not have 
Autoplay enabled, choose Run from the Start menu, type 
“d:\setup” (use the drive letter appropriate to the drive 
containing the installation CD) and press ENTER.

3. Follow the instructions on screen to complete the installation. 
Use the Next button to move forward between the installation 
dialogs.
Chapter 1: Windows EndNote Installation 13



Welcome: Thank you for selecting EndNote!

Registration Information: If you are installing the full 
version of EndNote, enter your EndNote product key. You 
must enter a valid product key to continue with installation of 
the full version of EndNote. The product key can be found in 
the EndNote X4 CD packaging, or on the order confirmation 
of your digital product. 

If you are installing the Demo version, choose the 
appropriate button. You do not need a product key or serial 
number to install the Demo version of EndNote.

User Information: Enter your name and organization.

If you are upgrading from a previous version, you must also 
enter your previous EndNote serial number. 

Read Me Information: Read late-breaking news about this 
version of EndNote.

Windows Mobile Read Me Information: Read late-breaking 
news about EndNote for the Windows Mobile OS.

 End User License Agreement: You must select “I accept 
the license agreement” in order to continue with the 
installation.

Select Installation Type: Typical installs the most popular 
100 output styles, most popular 100 filters, and most popular 
100 connection files. Limiting the number of files installed 
speeds up performance. Advanced users can choose 
Custom to hand pick the file groups to install, and add 
additional styles, filters, and connection files.

Select Destination: By default, EndNote is installed in the 
C:\Program Files\EndNote X4 folder. The Demo version is 
installed in the C:\Program Files\EndNote X4 Demo folder. You 
can use the Browse button to change the folder selection if 
you wish. 

If a previous installation of EndNote is found in the same 
folder, you will be given the option to either back up or 
overwrite the older files. If you back up files, they are placed 
in a Backup folder in the installation folder.

NOTE: If the installer detects a full version (not a demo version) of 
EndNote on your computer, it will give you the option to continue with 
the installation or quit. If you continue, be advised that you will need to 
reinstall your non-demo version of EndNote to use it after you run the 
EndNote X4 Demo version.
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Select Components: (Custom installations only) If you 
selected a Custom installation, see “Selecting Features” in 
this chapter.

Select Default Citation Manager: (Microsoft Word 2007 and  
2010 only) If the installer detects Microsoft Word 2007 or 
2010, it asks whether to “Use EndNote as my default citation 
manager.” Cite While You Write will be installed in Word 
2007 or 2010 in any case, but when this item is selected the 
installer will hide Word’s native Citations and Bibliography 
commands (the group normally found on the References tab 
in Word) in order to avoid confusion for the user. 

Ready to Install: You can still click Cancel to stop the 
installation. Once you click Next, the installation program will 
begin installing EndNote files.

4. On the final “EndNote X4 is Successfully Installed” dialog, 
click Register to register your copy of EndNote, click Finish 
to close the installation program, or click Run to start 
EndNote.

To make sure the program installed correctly, see “Checking 
Your Installation” on page 21.

Installed Files The full EndNote installation includes the following default 
folders and files.

Program Folder
C:\Program Files\EndNote X4, OR
C:\Program Files (x86)\EndNote X4  (64-bit Windows versions)

 EndNote X4.exe application file

 EndNote.chm help file
You can double-click the file to view it. In the EndNote 
program, select EndNote X4 Help from the Help menu. 
Pressing the F1 key on your keyboard or clicking a Help or ? 
button in the program brings up a context-sensitive topic.

 Readme.txt text file contains late-breaking news

 GettingStartedGuide.pdf gives a tour of the program

 Examples shortcut folder
This is a shortcut to an Examples folder that contains sample 
files to follow the guided tour found in Chapter 3 and the 
Getting Started Guide, and to experiment with while learning 
EndNote.

 Styles folder
This folder contains bibliographic styles for formatting 
citations and a bibliography. A Typical installation includes 
Chapter 1: Windows EndNote Installation 15



only the most popular 100 styles. With a Custom installation, 
you can choose from a full collection of over 4,500 
bibliographic styles.

 Connections folder
This folder contains connection files to connect to and search 
online bibliographic databases. A Typical installation 
includes only the most popular 100 files. With a Custom 
installation, you can choose from a collection of thousands.

 Filters folder
This folder contains import filters for importing text files 
downloaded from online bibliographic databases. A Typical 
installation includes only the most popular 100 files. With a 
Custom installation, you can choose from a collection of 
hundreds.

 Terms Lists folder 
This folder contains journal abbreviation term lists. These 
lists contain thousands of journal names and standard 
abbreviations. Import a list into your library’s Journals term 
list to use the abbreviations in your bibliographies.

 Spell folder 
This folder contains spell check dictionaries for the EndNote 
spell checker.

 Templates folder 
This folder contains Microsoft Word templates to quickly set 
up your papers for electronic submission to publishers.

 Pocket PC folder
This folder contains Read Me files and support files that allow 
you to keep an EndNote library on a Windows Mobile device. 

 Various additional folders and files are installed to support 
the EndNote program and to integrate EndNote with other 
software programs.

Shared Folder
Open the Shared Documents or Public Documents folder in 
Windows Explorer to find the EndNote folder located at:

Windows 7:  C:\Users\Public\Documents\EndNote

Windows XP:  Documents and Settings\All Users\Shared 
Documents\EndNote

Windows Vista:  C:\Users\Public\Public Documents\EndNote

 Examples folder
This folder contains a sample library and other sample 
documents and graphics to use while learning EndNote.
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 You may want to use the shared EndNote folder to store your 
libraries, so that they are available to all users on your 
computer.

Personal Folder
Open the My Documents or Documents folder in Windows 
Explorer to find the EndNote folder located at:

Windows 7:  C:\Users\UserName\Document\...

Windows XP:  C:\Documents and Settings\[UserName]\My 
Documents\EndNote

Windows Vista:  C:\Users\[UserName]\Documents\EndNote

These folders are created when you create or modify a file:

 Styles folder contains new or modified bibliographic styles

 Connections folder contains new or modified connection files

 Filters folder contains new or modified import filters

While the program folder contains the default styles, connection 
files, and filters, your personal EndNote folder contains those 
files that you have created or modified. This prevents changes to 
the original files, and assures that you will not inadvertently 
delete a customized file when you remove or upgrade the 
EndNote program. It also allows you to make changes to files 
even though you may not have administrator access to modify 
files in the Program Files folder. EndNote displays a single list of 
the files found in both locations. If a file of the same name 
appears in both locations, EndNote will display only the file found 
in your personal folder.

You can change your personal folder locations; see “Folder 
Locations” in EndNote help.

Preferences Folder
Depending on your settings, these folders may be hidden from 
view in Windows Explorer. 

Windows 7:  C:\Users\[UserName]\App Data\Roaming\EndNote

Windows XP:  C:\Documents and Settings\[UserName]\
Application Data\EndNote

Windows Vista:  C:\Users\[UserName]\App Data\Roaming\EndNote

While many EndNote preferences are stored in the Windows 
registry, some are stored in your personal preferences folder. It 
contains the connect.log file that records your latest online 
Chapter 1: Windows EndNote Installation 17



search, the RefTypeTable.xml file that stores your reference type 
preferences, saved search strategies, and various other settings.

Custom 
Installations/
Adding 
Content Files

Although we recommend that you use the Typical installation 
option to install EndNote, the Custom installation option can be 
useful if you are low on disk space, or if you need to reinstall only 
certain EndNote components, of if you would like to add 
additional content files (output styles, import filters, and/or 
connection files).

To do a new custom installation:
1. Follow the instructions for “EndNote Installation” in this 

chapter. 

2. On the dialog titled “Select Installation Type,” select Custom. 

3. When you get to the dialog titled “Select Features,” read the 
section below, “Selecting Features” on page 19 to determine 
what you would like to select/deselect for installation.

NOTE: If the installer detects another copy of EndNote in the 
destination folder, it gives you options to either backup or remove older 
files during the installation. When doing a custom install, only selected 
components are affected. For example, if you are installing only the 
Anthropology styles, and you choose to remove older files, only the 
older Anthropology styles are removed; no other part of the installation 
is affected.

To install components after EndNote X4 is already installed:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. Do one of these:

 Start the EndNote installation program as you would for a 
new installation.

 From the Windows Start menu, select Control Panel, or 
choose Settings and then Control Panel. Then, choose 
Add or Remove Programs. In the list, click on EndNote X4 
and then Change.

3. On the “Application Maintenance” dialog, select the Modify 
option and click Next.

4. When you get to the “Select Features” dialog, read the 
section below, “Selecting Features” on page 19 to determine 
what you would like to select/deselect for installation.
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Selecting Features
There are several major categories of components that can be 
installed with EndNote.

The components you can select for installation include:
EndNote Application
 EndNote Program
 Sample Files

 EndNote Help
Word Templates/Add-ins: 
 Templates for Microsoft Word

 Cite While You Write for Microsoft Word
Additional Styles: These formats for creating bibliographies 
are grouped by type.

Additional Connections: These files for directly retrieving 
references from online reference databases are grouped by 
information service provider.

Additional Filters: These files for importing text files of 
reference data are grouped by information service provider.

Spelling Dictionaries: These are dictionaries available for 
the spelling checker.

EndNote for Windows Mobile: These are files required for 
using EndNote for theWindows Mobile operating system. 

Click the plus sign next to each category to display a detailed list 
of items. For each category or subcategory, click the triangle next 
to the name to select from the available installation options. To 
install a feature, select one of these:

 Will be installed on local hard drive.

 Entire feature will be installed on local hard drive.

Upgrading from an Earlier EndNote 
Version

Before you begin, back up any custom styles, import filters, and 
connection files that you do not want overwritten.

We strongly recommend that you uninstall any earlier version of 
EndNote before you install EndNote X4. See “Uninstalling 
EndNote” on page 23. 

During installation, you will need to enter both your new EndNote 
X4 product key, which is found in the EndNote X4 CD packaging 
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or on the order confirmation for your digital product, and your old 
EndNote serial number. (The Demo version of EndNote does not 
require these.)

Install the upgrade just as you would a new installation. See 
“EndNote Installation” on page 13.  By default, EndNote X4 is 
installed into the C:\Program Files\EndNote X4 folder.

Backing Up or 
Replacing 
Files

If Setup detects an earlier copy of the EndNote program in the 
installation folder, it alerts you and gives you two options. If you 
continue with the installation to install EndNote X4 into your 
existing EndNote folder, Setup removes the older EndNote 
application and word processor support files. You need to select 
what it should do with the styles, filters, and connection files from 
your older copy of EndNote. No matter which option you choose, 
your libraries will not be deleted; nor will any non-EndNote files 
in the EndNote folder.

 Backup older files: EndNote X4 provides complete, updated 
sets of style, filter, and connection files, but if you want to 
keep any of your older modified files to use with EndNote X4, 
you should choose this option. Doing so has EndNote create 
a “Backup” folder in the EndNote folder and all of the styles, 
filters, and connection files from your older installation are 
copied into that folder. After installing EndNote, you should 
move any of these files that you want to use into the Styles, 
Filters, or Connections folders installed with EndNote X4.

 Remove older files: If this option is selected, Setup replaces 
all of the styles, filters, and connection files from your existing 
EndNote installation with the new ones included with 
EndNote X4. Do not choose this option if you have custom 
styles, filters, or connection files that you want to save. If they 
have the same names as any of the files to be installed, the 
installer will overwrite them with the new files.

Opening and 
Converting 
Old EndNote 
Libraries 

EndNote X4 opens and uses libraries created with EndNote 8 
and later. It converts libraries created with even earlier versions 
of EndNote to the latest file format. 

To convert an old EndNote library (created before version 8):
1. Start EndNote.

2. From the File menu, select Open and then Open Library. 

3. On the file dialog, locate and highlight the old library, and 
click Open.

EndNote will warn that the selected library was created with 
an older version, and will ask for permission to convert it. 
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4. Click OK to convert the library. Name the new library and 
click Save. The conversion makes a copy of the original 
library in the latest file format, and leaves the original library 
intact.

NOTE: Once you have opened and used a library with EndNote X4, you 
should use the library only with version X or later.

Using Old 
Style, Filter, 
and 
Connection 
Files

EndNote X4 can use custom styles, filters, and connection files 
that were created with EndNote versions 4.0.1-X4. Once you edit 
and save one of these files with EndNote X4, it is converted to 
the latest format, which can be used with EndNote versions 8 to 
EndNote X4.

All of the styles, filters, and connection files supplied with 
EndNote X4 have been updated to the latest format. The new 
filter and connection files can be used by previous versions of 
EndNote, with new fields simply ignored. However, the updated 
styles cannot be used with versions of EndNote prior to version 8. 

Checking Your Installation

To Begin 
Using 
EndNote

To run EndNote, click the Start button, choose All Programs, 
select EndNote, and then choose EndNote Program.

First, a dialog may ask whether you want to open a new EndNote 
Web account or integrate with an existing EndNote Web account. 
For information about EndNote Web, see “Transferring 
References between EndNote Web and Desktop” in EndNote 
help.

Next, a dialog may ask you to open a library file. You can create 
or open an EndNote library, or choose Cancel or Close. (A 
Sample Library is provided in an Examples folder to help you get 
familiar with EndNote.) To check the version number of EndNote, 
choose About EndNote from the Help menu. Click the splash 
screen to clear it. 

If you have trouble accessing the program, repeat the installation 
steps to verify that the program was correctly installed.

Checking Cite 
While You 
Write Support

To see whether Cite While You Write is correctly installed, start 
Microsoft Word or the OpenOffice.org Writer. 

 In Word 2003, click on the Tools menu and you should see 
EndNote commands on an EndNote X4 submenu. 
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 In Word 2007 and 2010, you should see an EndNote tab.

 In OpenOffice.org Writer, you should see EndNote 
commands on an EndNote X4 menu. 

Cite While You Write commands may not be available if you 
installed or upgraded your word processor after installing 
EndNote. 

If Cite While You Write commands do not appear in Microsoft 
Word or OpenOffice.org Writer, repair the EndNote 
installation:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. Make sure that all Microsoft Office and OpenOffice.org 
applications are closed, including any Quickstarter 
applications.

The OpenOffice.org Quickstarter may appear in your System 
tray. Right click on the icon and choose Exit Quickstarter.

3. From the Windows Start menu, select Control Panel, or 
choose Settings and then Control Panel.

4. Choose Add or Remove Programs.

5. Highlight EndNote X4 and click Change. 

6. Select Repair and click Next. 

Your entire EndNote installation is checked and repaired as 
needed. For more information, see “No EndNote commands in 
Word” in EndNote help.

Automatically Updating Files
You can automatically update EndNote X4 when incremental 
program enhancements are available. 

To update your copy of the EndNote program:
1. Open a connection to the Internet. 

2. From EndNote’s Help menu, select EndNote Program 
Updates. 
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The wizard checks for an update, lets you know whether an 
update is available, and then downloads the file(s) and applies 
the update to your EndNote installation.

NOTE: You also have the option to download the latest content files at 
any time from our Web site at http://www.endnote.com. We continually 
update output styles, filters, and connection files. 

Uninstalling EndNote
Before you remove EndNote, back up your libraries and any 
other files you have created or customized. 

For volume and site license installations, see “Licensing of 
Volume Copies” in EndNote help.

Uninstalling  
Word 2007 
and 2010 
Settings

Word 2007 and 2010 settings are typically registered during 
installation of the EndNote program, and in those cases they will 
also be uninstalled along with the program. You can jump to the 
next section, “Uninstalling the EndNote Program.”

If you used the Configure EndNote utility for a specific user 
account, to suppress the “Citations and Bibliography” group on 
the References tab in Word 2007 or 2010, you should use that 
utility again to uninstall. 

To uninstall Word 2007 or 2010 settings:
1. Log on to the workstation as the current user. You do not 

have to be an administrator.

2. Launch the Configure EndNote utility. You can do this in one 
of these ways:

 From the Windows Start menu, choose All 
Programs>EndNote>Configure EndNote.

 Go to the EndNote program folder and double-click 
"Configure EndNote.exe."

3. Select Remove all EndNote components for me and click 
Next. 

4. Continue through the uninstall process as instructed.

This uninstalls a single Word 2007 or 2010 setting, and only for 
the current user.
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Uninstalling 
the EndNote 
Program

To uninstall EndNote:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. From the Windows Start menu, select Control Panel, or 
choose Settings and then Control Panel.

3. Select Add or Remove Programs.

4. In the list of currently installed programs, select EndNote X4.

5. Click the Remove button.

Or, you can uninstall by using the EndNote installation 
program:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. From your EndNote CD, run Setup.exe.

3. On the “Application Maintenance” dialog, select Remove and 
click Next.

4. Click Next again to begin removing EndNote.

The uninstall procedure removes only files, groups, and icons 
installed by the EndNote installer the last time it was run. For 
example, if you used the installer’s Custom installation option to 
reinstall only style files, the Uninstall program removes only style 
files. 

To remove any modified EndNote files that remain:
We purposely do not remove any EndNote libraries or 
customized files. You can manually delete these files with 
Windows Explorer. Once you are sure you do not want to save 
any of the files contained in the following folders, you can delete 
them:

Windows XP
C:\Program Files\EndNote X4
C:\Documents and Settings\All Users\Shared Documents\EndNote
C:\Documents and Settings\[UserName]\My Documents\EndNote
C:\Documents and Settings\[UserName]\Application Data\EndNote

Windows Vista
C:\Program Files\EndNote X4
C:\Users\Public\Public Documents\EndNote
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C:\Users\[UserName]\Documents\EndNote
C:\Users\[UserName]\App Data\Roaming\EndNote

NOTE: If you are using a 64-bit version of Windows, your EndNote 
program folder will be: C:\Program Files (x86)\EndNote X4.
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Chapter 2: Introduction to an EndNote Library
This chapter covers the basics of working with EndNote. In 
particular, you will learn how to: 

 Start EndNote and open a library.

 Sort the reference list.

 Select, open, and close a reference in the EndNote library.

 Save references to custom groups.

 Quit from the EndNote program.

Start EndNote To start the EndNote program and open the sample library:
1. From the Start menu, choose Programs > EndNote > 

EndNote Program. If this is the first time you have used the 
program, a dialog appears prompting you to open a 
reference library.

NOTE: If you have set a favorite library to open automatically, that 
library will open instead of the dialog shown above. If this happens, 
close the library, go to the File menu and choose Open > Open Library, 
and continue with step 3.
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2. Click the File Cabinet icon next to “Open an existing EndNote 
library.”

3. In the file dialog, locate and open a reference library. Use the 
Look in: menu to find the EndNote X4/Examples folder. 

 Choose the C: drive and Open.

 Choose Program Files and Open. 

 Choose the EndNote X4 folder and Open. 

 Choose the Examples folder shortcut and Open. The 
Examples folder is actually in your Shared Documents or 
Public Documents folder.

The example library is shipped to you as a single 
compressed file called Sample_Library_X4.enlx. Open the 
Sample_Library_X4.enlx file and EndNote extracts the 
uncompressed library files (Sample_Library_X4.enl and 
Sample_Library_X4.Data) and opens them for viewing.

If you have previously opened the compressed sample 
library, select Sample_Library_X4.enl, and then click Open.

NOTE: You can open a library from within EndNote. From the File 
menu, choose Open > Open Library.

the compressed library
the uncompressed library
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The Library 
Window

When you open the sample library you see the Library window 
listing all of the references that the library contains:

The Library window includes three panes:

Reference List pane: Displays a multi-column list of references. 
By default, the first column in the reference list shows a paper 
clip icon for references that include an attached file in the File 
Attachments field. This is followed by:

 First author’s last name

 Year

 Title

 Journal name or secondary title

 Reference type

 URL

Move column dividers to adjust column widths
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 Last Updated 

NOTE: You can changes the order of the fields that display in the 
reference list by selecting from the Edit menu, Preferences > Display 
Fields.

Groups pane: Displays various group sets that contain groups 
of references for easy retrieval.

Tab pane: Displays a Preview tab to view formatted references, 
a Search tab for searching either the current library or an online 
database, and a Quick Edit tab allowing you to quickly edit a 
reference.

The information displayed in the reference list, as well as the font 
used for the display, can be changed using EndNote 
Preferences. 

You can browse through the reference list by first selecting a 
reference, and then using the scroll bar, the scroll arrows, or the 
PAGE DOWN, PAGE UP, HOME, END, and ARROW keys. 

Preview 
References

You can easily see more detail about a reference by highlighting 
the reference and viewing the Preview tab at the bottom of the 
Library window.

To preview a reference:
1. First, if you do not have a Tab pane in the window, click the 

Show Tab Pane button at the bottom of the window, and then 
click the Preview tab. 

2. For this example, click the reference titled “Bats: Biology, 
behavior, and folklore.”

The Preview tab uses the current output style to display the 
selected reference as it will be formatted for a bibliography. 
EndNote’s output styles (or just styles) represent the rules for 
creating bibliographies for a variety of journals and other 
publications. The styles determine how your references look 
when you print, export, preview, or create bibliographies.
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3. To select a different output style to apply to the reference, go 
to the toolbar and select Numbered from the drop-down list 
of output styles.

NOTE: The style list displays your “favorite” output styles, but you can 
choose Select Another Style to pick from other installed files. A Typical 
installation installs the 100 most popular output styles, but more than 
4,500 output styles are available with EndNote.

Only one reference is displayed on the Preview tab at a time. If 
multiple references are selected, only the active reference 
(surrounded by a dotted line) is displayed. 

The format of the reference on the Preview tab can be changed 
at any time by choosing a different output style.

When the Tab pane is showing, a Hide Tab Pane button is 
available at the bottom of the window. You can click Hide Tab 
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Pane to hide the Preview tab. The name of the button will toggle 
to Show Tab Pane.

Sort the 
References

References can easily be sorted by clicking on a column heading 
such as Author, Year, or Title. 

To change the sort order:
1. Click the Author column heading to change the current 

Author sort from ascending order to descending order.

NOTE: This example shows references that include Japanese 
characters. EndNote uses Unicode to encode special characters, so 
that data is easily translated between platforms, programs, and 
languages. If boxes appear instead of characters, you may need to 
change the EndNote display fonts to a Unicode font. You will learn how 
to do this in Chapter 3: "Setting EndNote Preferences". For some 
display elements, you may need to install special Windows Language 
Packs. Consult your Windows documentation for more information 
about Language Packs.

2. Click the Year column heading to see the references sorted 
in ascending order based on the year of publication.

3. Click the Year column heading again to reverse the sort order 
and see the references sorted in descending order.
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4. Click the Author column heading to return the sort order of 
the library to an alphabetical list sorted by the author names.

Select and 
Open a 
Reference

To work with specific references, you must first select them in the 
Library window.

There are different ways to select a reference, such as clicking 
on the reference using the mouse, using the arrow keys, or typing 
the first few letters found in the field by which the library has been 
sorted.

To see how this works, click any reference to select it. Press the 
UP or DOWN ARROW to select the previous or next reference.

To quickly find and display a reference:
1. Select the first Argus reference in the list.

Now that the reference is selcted, there is a number of things 
you can do with it, such as view its contents, copy, cut, 
delete, or edit it. For now, just open the reference to view the 

contents.

2. Open the selected Argus reference by pressing the ENTER 
key or by using the Edit References command on the 
References menu. You can also open a reference by 
double-clicking on it in the reference list.
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The Reference window opens to display all of the information 
associated with the reference.

This is where you enter or edit information for a reference. 

NOTE: The citation information is displayed at the top of the Reference 
window in the title bar, “Argus, 1993 #15.” This information - the first 
author’s last name, year, and record number - is used by EndNote to 
match citations in a paper to references in a library.

To view the rest of the reference, use the mouse to scroll down 
the Reference window, or press the TAB key to move forward 
from one field to the next. 

 Press SHIFT+TAB to move backward through the fields. 

 Click the Show Empty Fields/Hide Empty Fields button to 
toggle between showing all fields in the reference and only 
those fields that contain data.

Close the 
Reference

Close the reference. You can do this in one of these ways:

 Click the X close button in the upper corner of the Reference 
window (not the outer close button for the library).

title bar
Show or Hide empty 
fields in the reference.

Click and drag to resize the window.
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 From the File menu, choose Close Reference. 

 From the keyboard, press CTRL+W. Note that many of the 
menu commands have a keyboard equivalent next to them.

EndNote automatically saves all changes to a reference when 
the Reference window is closed.

Quick Edit 
Pane

The Quick Edit pane in the Preview area of the EndNote window 
displays the contents of the highlighted reference. Each part of 
the reference is stored in its own field, and the reference type is 
displayed below the title bar.

You can quickly edit your references by clicking on the Quick Edit 
tab. Most functionality is the same as working in the Reference 
window. Enter text in a field by clicking on the field. All commands 
are available via the menus including contextual menus. 

Save 
References to 
a Custom 
Group

The left pane of the Library window lists groups of saved 
references. The first three groups are permanent. 

 All References displays all of the references in the library.

 Unfiled contains references that are not part of a custom 
group.

 Trash contains references that have been deleted from the 
library but not yet permanently eliminated. 
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Below the permanent groups, you can create group sets to 
organize up to 500 custom and smart groups in the library. 

A custom group is built by specifically adding individual 
references to the group. A smart group is compiled automatically, 
and is based on a search strategy. You can even create a 
combination group that consists of custom and/or smart groups.

The sample library has several custom groups of references. 
Click the group names under the Bats set in the left pane of the 
library window to view the references in each group. 

Then, click All References to display all of the references in the 
library again.

To create a custom group and add references to it:
1. Display one of the groups in the Paleontology set, so that the 

new group will be created in that set.

2. From the Groups menu, select Create Group. You could 
right- click under the Paleontology group in the Groups pane 
to display a context-sensitive menu, and then select Create 
Group.

In the Groups pane of the Library window, a group titled New 
Group is now highlighted for editing. 

3. Type “Extinction” as the group name, and then press ENTER 
or click in the reference list area to save the change. 

There are no references in the new Extinction group.

4. Click the All References group to display all references in the 
library.

5. In the Author column, highlight the first reference by Argus 
and the first reference by Billoski. To select noncontiguous 
references, hold down the CTRL key as you click on them.

6. Drag the selected (highlighted) references to the new 
Extinction group and drop them on the title of the group. You 
could go to the Groups menu and choose Add References To 
> Extinction.

Custom groups

Smart group

Group set name
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7. Click the Extinction group to display the two references now 
included in the group.

Click All References to display all of the references in the library 
again.

To move the group to a different group set:
1. Click the group title Extinction to display the group.

2. Drag it to the Bats group set, and drop the group anywhere 
in the Bats set.

To delete a custom group:
1. Right-click the Extinction group name to display a context-

sensitive menu, and then choose Delete Group. 

Or, you could click the group name, and then select Delete 
Group from the Groups menu.

2. When you are asked to verify the deletion, click Delete.

Only the Group subset is deleted; no references are deleted from 
your library.

Many of the commands for managing groups are available both 
from the Groups menu and from the right-click context-sensitive 
menu.
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Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “The EndNote Library” to learn how to change the display of 
the Library window.

 “Sorting the Library” to learn more about sorting.

 “Using Groups” to learn more about creating and managing 
groups.
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Chapter 3: Setting EndNote Preferences
In this part of the guided tour you will learn how to:

 Display EndNote Preferences.

 Set a favorite library to open each time you start EndNote.

 Change the display fonts.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X4.enl as shown in “Start EndNote” on 
page 27.

Access 
EndNote 
Preferences

To view or change the EndNote preferences:
From the Edit menu, choose Preferences.

Set a Default 
Library

You can assign a library to open automatically every time you 
start EndNote. You will find it useful to set the sample library 
(Sample_Library_X4.enl) as your favorite library for now. Later, 
when you create your own library, you can set it as your favorite 
library. 

To set a favorite library:
1. Go to the Edit menu and choose Preferences. 

2. In the list on the left, click Libraries.

3. Choose Open the specified libraries from the When EndNote 
Starts menu.
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4. Click Add Open Libraries. You should see the full path and 
file name of the sample library (Sample_Library_X4.enl) 
listed at the top of the box. 

5. Click Apply to save this change. 

While you could click OK to leave the Preferences dialog, we are 
going to change another preference first.

Change the 
Library 
Display Font

Pick a different font to display text in the Library window and the 
Reference window. 

To change the display fonts:
1. Go to the Edit menu, and then choose Preferences. 

2. In the list on the left, click Display Fonts to display a dialog 
with four tabs.

 The Library tab determines the font and size of the 
references listed in the Reference List pane of the Library 
window. 

 The General tab changes the font used to display most 
text that is typed into EndNote such as in the Reference 
or Style windows. The General font is also used for most 
of the previews and information panels in EndNote, as 
well as for bibliographies that are printed or copied 
directly from EndNote. 

 The Labels tab determines the font and size used for the 
Reference window field labels. 
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 The Search tab determines the font and size applied to 
user-entered text on the Search tab.

3. On the Library tab, click the Change Font button. 

4. In the Font list, choose Arial Unicode MS (or another Unicode 
font that supports Japanese characters). Click OK to save 
the change.

EndNote uses Unicode to correctly handle extended 
characters. By selecting a Unicode font here, you can view 
extended characters in the Library window, such as the 
Japanese characters found in the sample library.

5. On the General tab, click the Change Font button. 

6. In the Font list, select Arial Unicode MS (or another Unicode 
font that supports Japanese characters). Click OK to save 
the change.

7. Click OK to leave the Preferences dialog.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “The EndNote Library” to learn how to change the display of 
the Library window.

 “Preferences, Toolbars, & Shortcuts” to learn how to 
customize your version of EndNote.
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Chapter 4: Entering a Reference
In this part of the guided tour you will learn how to:

 Enter a reference into a library.

 Attach a file to a reference.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X4.enl as shown in “Start EndNote” on 
page 27.

Create a New 
Reference

There are various ways to add references to an EndNote library:

 Type the reference information into the Reference window.

 Connect to an online bibliographic database and retrieve the 
references directly into EndNote as demonstrated in 
“Searching an Online Database” on page 49. 

 Import text files of references that have been downloaded 
from online bibliographic databases as demonstrated in 
“Importing Reference Data into EndNote” on page 61. 

Once a library is open, you can add a new reference to it:
1. Click in the reference list, and then from the References 

menu, choose New Reference (CTRL+N) to display an empty 
Reference window.

New references appear as journal articles (unless you 
change the default setting) but can be changed to any other 
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type of reference using the Reference Type list at the top of 
the window.

2. Choose a reference type. Click the Reference Type list and 
choose Book.

Notice that the Field list changes to reflect the type of 
bibliographic information you would record for a book. Select 
other reference types from the list to see how the list of fields 
changes for each type of source.

Three reference types - Figure, Chart or Table, and Equation 
- are available specifically for cataloging picture files and 
object files, although you can add File Attachments, Figures, 
and Captions to any reference type. 

When you are done looking at different reference types, set 
the reference type back to the Journal Article reference type. 
You are now ready to enter reference information beginning 
with the author names. 

3. Enter author names for the reference. Individual author 
names must be entered one per line.

a. Enter a personal author name with the first name first. 
With the cursor in the Author field, type:

Tiberius Rex

As you type, EndNote suggests names similar to the one 
you are entering. This is EndNote’s way of using term 
lists to facilitate the process of entering new references. 

Reference Type 
set to “Book”
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NOTE: The auto-complete feature can be turned on or off with EndNote 
Term List preferences. It is available for Author fields when you enter 
author names with the last name first.

The name you are entering, Tiberius Rex, is a new author 
in this library, so keep typing until you complete the 
name, and then press the ENTER key. 

The name appears in red text to indicate that it is a new 
name in the Author term list for this library. When you 
close the reference, it will be added to the Author term list 
and the red text will change to black. You can read more 
about term lists (and how to turn these options on or off) 
in EndNote help.

b. Enter the second author’s name, but with the surname 
first.

Morre, Nicole

This author’s last name is already in the sample library, 
so as you start typing the last name, you will see 
EndNote complete the name for you.

Press ENTER to accept EndNote’s suggested author 
name.

c. For the third author, enter:

de Young, John Robert, Jr.

The first comma separates the last and first name. The 
second comma is inserted before suffix text, to make it 
clear that it is not part of the author’s name for 
manipulation of name order or stripping to initials. Suffix 
text will always print after the other information for this 
author. Press ENTER. 

d. For the fourth author’s name, which in this case is a 
corporate author, enter:

University of California,, Berkeley

Corporate author names are entered with a following 
comma, so they will not be manipulated like personal 
author names. In this case, the corporate author name 
has a comma within the name. We inserted two commas 
to allow for correct formatting. The first comma makes it 
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clear that text up to that point should not be manipulated, 
and the second comma indicates that there is no “first 
name,” yet includes suffix text.

4. Press TAB to accept the author name and move to the Year 
field. Type: 

2006

5. Continue entering the reference as shown below using the 
TAB key to move to the next field and SHIFT+TAB to move to 
the previous field. You can also use the mouse to click in the 
desired field. If information is not provided for a particular 
field, leave that field empty.

Title:The scale and the feather: A suggested 
evolution

Journal:Paleontology

Volume:3

Issue:1

Pages:125-128

Date:November 22

Keywords:Feathers
Evolution
Birds

No extra punctuation (such as parentheses around the year) 
or text styles (such as bold or italic) are entered into the 
reference. EndNote adds the necessary punctuation and text 
style changes to the references when it creates a 
bibliography. 

While we are not entering any text into the Abstract or Notes 
fields, you could enter up to 64 K of text into each of these 
fields, which amounts to 10-12 pages of text.

6. Attach a PDF file to the reference. You can attach almost any 
type of file to the File Attachments field of a reference.

Scroll to the File Attachments field, and from the References 
menu, select File Attachments > Attach File to display a file 
dialog. On the file dialog:

a. Navigate to the folder Program Files\EndNote X4. 

b. Notice the check box titled “Copy this file to the default 
file attachment folder and create a relative link.” Make 
sure this box is selected so that EndNote will make a 
copy of the file to store with the library. That way, the 
attached file is always available to you, even when you 
move the library.
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c. Highlight the file titled EndNote.pdf. This is the full 
EndNote help system located in the EndNote program 
folder. 

d. Click Open to insert the file into the File Attachments 
field. A file icon will appear in the field.

You can attach up to 45 different files to a single reference, 
and you can double-click a file icon to open the file with the 
default application. 

7. Close the Reference window by choosing Close Reference 
(CTRL+W) from the File menu.

8. When prompted to save changes, click Yes. Your new 
reference will appear in the Library window. 

A paper clip icon appears next to the reference to indicate an 
attached file.
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Locate 
References 
that Contain 
Attached Files

You can easily locate those references that contain attached 
files.

To locate the references containing attached files:
Click the paper clip icon in the first column heading twice to sort 
records containing attached files at the top of the list. References 
that include a paper clip have one or more attached files. 

You can double-click an individual reference if you would like to 
view the complete reference. When you are done viewing a 
reference, click the Close button.

Click the Author column heading to again order the list by author 
names in ascending (A to Z) order.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “The EndNote Library” to learn how to create your own 
library.

 “Entering and Editing References” to learn about typing 
references into your library and inserting images.
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Chapter 5: Searching an Online Database
With the EndNote Online Search command, you can search 
online bibliographic databases just as easily as you can search 
an EndNote library on your own computer. The results of your 
searches can be downloaded either into a temporary EndNote 
library or directly into your own EndNote library.

Another way to search online sources is with the Find Full Text 
command, which locates full text articles for your existing 
EndNote references.

This section will guide you through these basic steps:

 Connect to an online database.

 Search the database and download the references into an 
EndNote library.

 Find and attach the full text article for a reference. 

NOTE: In order to follow this exercise, you must be at a computer with 
access to the Internet (either dial-up or a direct network connection).

About the PubMed Database
For this lesson, you will connect to PubMed, the U.S. National 
Library of Medicine’s online public access version of their 
MEDLINE database. 

For Users With “Dial-up” Internet Connections
If you use a modem and a phone line to connect to the Internet, 
as opposed to a direct network connection, this section pertains 
to you.

Connecting: Most setups for dial-up connections are configured 
to automatically dial your information provider and connect to the 
Internet when you use an application that requests an online 
connection (as EndNote’s Online Search command does). 
However, some setups require that you establish an online 
connection (sign on) before choosing EndNote’s Online Search 
command. 

Disconnecting: EndNote disconnects from an online database 
as soon as a search is completed, but will not disconnect your 
Internet connection at any point. You need to shut down your 
connection when you have finished using EndNote’s Online 
Search feature.
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Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X4.enl as shown in “Start EndNote” on 
page 27.

Select a 
Display Mode

You can choose from different display modes in the Library 
window by selecting one of these from the toolbar.

 Integrated Library & Online Search Mode

 Local Library Mode

 Online Search Mode

There are actually two different workflows. You may want to 
always work in Integrated Mode, with all groups and commands 
available, and with online search results downloaded directly into 
your open library. Or, you may want to work primarily in Local 
Library Mode, with Online Groups suppressed until you explicitly 
switch to Online Mode to download references into a temporary 
library.

 In Integrated Library & Online Search Mode, all groups and 
commands are available. When you download references 
from an online database, they are saved directly into the 
open library. 

 In Local Library Mode, the Online Search groups are not 
available. All local library commands are available. If you 
initiate an online search from the Tools menu, the display 
switches to Online Search Mode.

 In Online Search Mode, only the Online Search groups are 
available. When you download references from an online 
database, the references are stored in a temporary library 
until you save them to a permanent EndNote library. This 
allows you to download references from online databases 
and review them without affecting your local library. Many 
library commands are not available in Online Search Mode. 
When you close Online Search Mode, the display changes to 
Local Library Mode.

Try clicking on the three different mode buttons at the left of the 
toolbar to see how the Groups pane changes in the Library 
window. 

Integrated Library & 
Online Search Mode

Local Library Mode

Online Search Mode 
(Temporary Library)
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To continue the tour, click the left icon to select Integrated Library 
& Online Search Mode so that all groups and commands are 
available. 

Connect to an 
Online 
Database

The first step in searching an online database is connecting to it.

To connect to the PubMed Database:
1. Go to the Tools menu and select Online Search to see the 

available list of online databases. You could also look under 
Online Search in the Groups pane, and then click more.

NOTE: The Groups pane will remember databases you have connected 
to in the past for easy access under Online Search. You can also 
customize a list of favorite databases to search by using the Connection 
Manager.

NOTE: This window displays the connection files available in your 
Connections folders. A Typical installation installs the 100 most popular 
connection files, but more than 4,100 connection files are available with 
EndNote.

Click to 
show more 
or less info 
about the 
selected 
connection 
file.
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Use the Find by list to quickly view various categories of 
databases to help you locate the one that you need. Or, type 
text into the Quick Search text box and press ENTER.

2. Select the PubMed connection file, and then click Choose. 
You can begin entering your search terms in the fields.

By selecting that connection file, you have directed EndNote to 
connect to the National Library of Medicine’s PubMed database. 
If for any reason the connection cannot be established, EndNote 
alerts you with an error message and closes the connection.

When the connection has been established, EndNote displays a 
Search tab titled, “Online Search - PubMed MEDLINE at PubMed 
(NLM).” The PubMed MEDLINE database is selected and 
EndNote is ready to search.

NOTE: For more detailed information on how to search PubMed, 
see “Importing References from PubMed” in EndNote Help.

NOTE: If you previously set a default configuration for the Search tab, 
the search field lists display the fields you selected as your defaults. If 
one of these fields appears italicized in the Search tab lists, that 
indicates it is not a valid option for this particular online database.

Search the 
Database

The next step is to enter the search term(s) to find the references 
you need. Searching an online database is very similar to 
searching an EndNote library, with a few exceptions. 

Let’s say you are interested in finding more information about 
fossils for the sample library. 
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To enter the search term(s) and perform the search:
1. Set the Field list for the first line to MeSH Terms, and enter 

“fossil” into the search text field. The Comparison list for 
online searches is always set to Contains.

2. Click Search. 

EndNote sends the search request off to the online database 
(PubMed MEDLINE, in this example), and a summary of the 
search results is displayed:

The dialog displays the number of references that were found 
to match your search request, and gives you the option to 
retrieve them. 

NOTE: You can halt a retrieval in progress by clicking the Cancel button 
on the Search tab. Records that have been processed up to that point 
already exist in the library.

NOTE: PubMed is updated regularly, so you may find a different 
number of references than illustrated here.

If the result set seems too many, you can refine the search to 
get closer to exactly those references you want. Let’s refine 
this search by looking for just those references that include 
mention of a “trilobite,” a group of extinct marine animals that 
were abundant in the Paleozoic era.

field 
list

comparison 
list

search 
term

logical 

Match Case and Match Words are 
not available for online searches
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3. Click Cancel, and you are returned to the Search tab.

4. Set the operator at the beginning of the second search line to 
And.

5. In the second search line, select All Fields from the Field list 
and type “trilobite” as the search text.

6. Click Search.

This time fewer references are found.

7. Click OK to retrieve and save the matching references. 

The references are downloaded into your library and appear 
both in the All References group and in a temporary group for 
the PubMed database connection. 
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NOTE: If you would prefer to save references to a temporary library 
first, to verify which references you want to save, you would have begun 
by selecting Online Search Mode. 

The temporary PubMed (NLM) group will reset back to 0 
references when you close the library.

NOTE: You can click the plus or minus icon next to a group set heading 
in order to display or hide the list of groups under that heading.

Review the 
References

At this point you can peruse the retrieved references to make 
sure you want to keep all of them. You may find that some of the 
references are not helpful for your research.

While you could open each reference individually to scan through 
the bibliographic data, you can also use the Preview tab.

To quickly look at the new references:
1. Click on a reference in the reference list.
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2. In the Tab pane, click the Preview tab to display a reference 
preview.

3. On the toolbar, select the Show All Fields output style from 
the Output Style list.

The Show All Fields style is not bibliographic, but represents 
all of the fields in your references. On the Preview tab, you 
can scroll through the data in the selected reference.

NOTE: If Show All Fields is not in the Output Style list, then choose 
Select Another Style to go to the Choose a Style dialog. Select Show 
All Fields from the list.

Delete 
Unwanted 
References

Because you are working in the Integrated Mode display, 
references were downloaded directly into the open library. Any 
references you do not want must be deleted. 

NOTE: If you had downloaded references in Online Search Mode, the 
references would be in a temporary library; you would need to highlight 
the references you wanted to keep and copy them into a permanent 
EndNote library.

To delete references:
1. In the PubMed (NLM) group, select two of the displayed 

references by holding down the CTRL key and clicking on the 
individual references. (Use SHIFT+click to select a range of 
references.) 
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2. From the References menu, select Move References to 
Trash. The selected references are removed from the library 
and put in the Trash group.

While the references are officially no longer in your library 
(they will not appear in any other group or reference list, they 
are not included in your reference count, and they cannot be 
cited), they are not completely deleted until you go to the 
References menu and choose Empty Trash. Until you 
choose Empty Trash, you can still drag references from the 
Trash group back to your active library.

3. Because you are sure that you want to delete the references, 
click the Trash group, and then go to the References menu 
to select Empty Trash.

4. Confirm the deletion by clicking OK.

5. Click the All References group to return to the full reference 
list, and on the toolbar, set your output style back to 
Numbered.

If you wanted to do another search of PubMed, you could display 
the PubMed group, enter another search strategy, and then click 
Search again. On the Confirm Online Search dialog, you are 
asked, “Clear currently displayed results before retrieving 
records?” This check box simply removes the previous 
downloaded references from the PubMed group; they still exist in 
the library. It is an easy way to see just those references 
downloaded with the current search strategy.

Find the Full 
Text for a 
Reference

Many online sources now supply not only bibliographic 
information, but the full text of the document you are referencing. 
In this exercise, you will find the full text for a reference, and 
attach the PDF file to the reference.

To find the full text for a reference:
1. Click in the list of All References and type “Kelly” to jump to 

the reference by the author Kelly.

2. Highlight the reference by Kelly as well as the next reference, 
by the author Knell.

3. From the References menu, choose Find Full Text > Find Full 
Text.

EndNote displays a copyright notice, advising you to adhere 
to downloading and usage guidelines as required by your 
information provider. We will use the default EndNote 
settings to search public sources that do not require 
authentication for access.
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4. Click OK to begin the Find Full Text search.

In the left-hand column, under the Find Full Text group set 
heading, you will see a Searching group, indicating that a search 
is in progress. This search can work in the background, so if you 
had many references selected, you could continue working in 
your library.

When the Find Full Text search is completed, the Searching 
group is removed. Depending on the results, you may see a 
combination of three different groups under the Find Full Text 
heading.

 Found PDF

 Found URL

 Not found

In this case, EndNote was able to locate a PDF file for one of the 
references.

In the reference list, you can see that the Kelly references has a 
paper clip icon next to it, indicating an attached file. 

You could open the Kelly reference, double-click the PDF icon in 
the File Attachments field, and read the entire article.

The Knell reference and the Kelly reference each had a URL 
added to the URL field. The URL will take you to the provider’s 
Web site where either the full text article is available, or you will 
find information about how to obtain the full text article.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Searching Online Databases” to learn about establishing 
connections, searching for references, retrieving references, 
and finding the full text for a reference.

 “Troubleshooting” to learn how to resolve problems 
establishing a connection.
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 “Connection Files” to learn about creating and editing 
connection files.

 “Importing References from PubMed” to learn how to import 
records from the PubMed database.
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Chapter 6: Importing Reference Data into 
EndNote

Online searching, described in the previous section, is the 
easiest way to retrieve references from online databases, but not 
all information providers offer that option.

If you have access to an online bibliographic database or 
university catalog, you can probably use EndNote’s import filters 
to import text files saved or downloaded from these sources. 
EndNote filters are configurable, so they give you the flexibility to 
import the reference data you need and eliminate data you do not 
need. 

In this part of the guided tour you will learn about:

 Downloading data in a tagged output format.
 Selecting an import filter and importing data into EndNote.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X4.enl as shown in “Start EndNote” on 
page 27.

Search the 
Database and 
Save the 
References

Often when you search a database, the matching references are 
displayed as text, with no clear indicator between each piece of 
bibliographic information. The PubMed reference below, saved in 
a Citation format, is an example. There is no clear indicator for 
EndNote to be able to differentiate a title from an address or an 
abstract.

Science. 1966 Dec 9;154(3754):1333-1339.

Early Eocene Bat from Wyoming.

Jepsen GL.

    A fossil skeleton of an early Eocene bat, the 
oldest known flying mammal, was found in 
southwest Wyoming. The bat is assigned to the new 
species Icaronycteris index of the suborder 
Microchiroptera. It was apparently of a young 
male whose body was buried in varved marls of the 
Green River Formation, on the bottom of Fossil 
Lake, about 50 million years ago. The bones, some 
as slender as a human hair, show a few 
"primitive" characteristics such as a clawed 
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index finger and a complete phalangeal formula, 
but the bat was fully developed -an anatomically 
precocious contemporary of the dog-sized 
polydactylous horse.

    PMID: 17770307 [PubMed - as supplied by 
publisher]

To use this information effectively, each piece of bibliographic 
information must be consistently tagged so it can be directed to 
the correct EndNote field.

Database providers typically offer several different download 
formats. Regardless of which system you are searching, you 
need to save the references in a tagged format to a text file.

For this tour, we will use a text file of PubMed references that 
were previously downloaded in the tagged MEDLINE format. The 
file pubmed_result.txt is provided in the EndNote Examples 
folder. A single reference in the file appears like this:

PMID- 18198331
OWN - NLM
STAT- MEDLINE
DA  - 20080116
DCOM- 20080313
LR  - 20081121
IS  - 0890-9369 (Print)
VI  - 22
IP  - 2
DP  - 2008 Jan 15
TI  - Understanding of bat wing evolution takes 

flight.
PG  - 121-4
AD  - Department of Genetics, Harvard Medical 

School, Boston, MA 02115, USA.
FAU - Cooper, Kimberly L
AU  - Cooper KL
FAU - Tabin, Clifford J
AU  - Tabin CJ
LA  - eng
GR  - F32 HD 052349/HD/NICHD NIH HHS/United 

States
GR  - R37 HD 32443/HD/NICHD NIH HHS/United States
PT  - Comment
PT  - Journal Article
PT  - Research Support, N.I.H., Extramural
PL  - United States
TA  - Genes Dev
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JT  - Genes & development
JID - 8711660
RN  - 0 (Homeodomain Proteins)
SB  - IM
CON - Genes Dev. 2008 Jan 15;22(2):141-51. PMID: 

18198333
MH  - Animals
MH  - Chiroptera/*genetics
MH  - *Evolution
MH  - Forelimb/anatomy & histology
MH  - Fossils
MH  - *Genetic Variation
MH  - Homeodomain Proteins/*genetics
MH  - Wing/*growth & development
EDAT- 2008/01/17 09:00
MHDA- 2008/03/14 09:00
CRDT- 2008/01/17 09:00
AID - 22/2/121 [pii]
AID - 10.1101/gad.1639108 [doi]
PST - ppublish
SO  - Genes Dev. 2008 Jan 15;22(2):121-4.

Each tag can be mapped to a corresponding EndNote field. If 
data is inconsistently tagged, or poorly delimited, it may not be 
possible to import all of the data accurately.

Choose the 
Correct Import 
Filter and 
Import into 
EndNote

Once you have captured and saved your data file in a tagged 
format, you need to identify the proper EndNote filter to import 
the data. There are hundreds of filters included with EndNote; 
each one is designed to read a specific tagged format from a 
specific information provider.

To import the sample PubMed text file into the sample 
library:
1. View the Library window in EndNote.
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2. From the File menu, choose Import File.

3. Click the Choose button to display a file dialog.

4. Browse to the EndNote X4\Examples folder, and then 
highlight and Open the pubmed_result.txt file.

5. From the Import Option list, select Other Filters to display the 
list of filters supplied in the EndNote Filters folder. 

You may want to peruse the list, to get an idea of what filters 
are supplied. You can create new filters or copy and edit 
existing filters.

NOTE: A Typical installation installs the 100 most popular filters, but 
there are hundreds available with EndNote.
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6. Type “PubMed” to jump to the filter in the list.

If the More Info button is available, click it and notice that the 
Comments section at the bottom of the window gives tips for 
downloading references from the selected source.

7. With the PubMed (NLM) filter highlighted, click Choose.

8. Leave the other two options at their default settings:

Duplicates: Import All

By default, a reference is considered a duplicate if the 
Author, Year, Title, and Reference Type match a reference 
already in the library. You can change the duplicates criteria 
under EndNote Preferences. We will import all references 
regardless of duplicates.

Text Translation: No Translation

This option allows you to specify the text character encoding 
of the file you import. This is important when you import 
references in languages that include extended characters. 
You can also find the correct language encoding information 
by opening the text file in Microsoft Word or another word 
processor.

9. Click Import to import the file.
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When the process is complete, only newly imported 
references display in the reference list. This is a good time to 
peruse the new references to make sure they imported as 
expected. You can display the Preview tab to view the 
formatted references, you can open individual references to 
make sure all information transferred to the correct fields, 
and you can easily edit or delete the new references.

Notice that the focus in the Groups pane has switched from 
the All References group to a new Imported References 
group. 

The Imported References group is a temporary group. It is 
replaced each time you import a new set of references, and 
it is removed when you close the library. The references 
themselves remain in the library unless you specifically 
delete them.

10. To return all of your references to the library display 
(including the newly imported references), choose Show All 
References from the References menu or click the All 
References group.
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Summary of 
Output 
Formats and 
Matching 
Import 
Options

A subset of supported information providers are listed here with 
their recommended output formats. Check this list for guidance 
in order to download in the appropriate tagged format and select 
the appropriate import filter. This information was accurate at the 
time of publication, but you may need to contact your information 
provider if changes occur. You can also check our Web site at 
http://www.endnote.com for updated information and import 
filters.

NOTE: Some of the services listed in this table, such as EBSCO and 
WilsonWeb, have an alternate, easier way of transferring references 
into an EndNote library. See “Direct Export from Web Pages” on page 
73. 

Copyright Issues and Fair Use of Downloaded Data
EndNote gives you the capability to import references downloaded from 
online databases into its libraries. Some producers of online reference 
databases expressly prohibit such use and storage of their data; others 
charge an extra fee for a license to use the data in this way. Before you 
download references from a database, be sure to carefully check the 
copyright and fair use notices for the database. Note that different 
databases may have varying restrictions, even from the same information 
provider (such as DIALOG or Ovid). 
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Output Formats and Corresponding Import Options
Information Provider Recommended Download Format Import Option

AARP AgeLine
(http://
research.aarp.org/
ageline/home.html)

There is no method for downloading data from this 
database. Instead, save the results screen as a 
plain text file with your Web browser’s Save 
command. The resulting text file contains tags which 
are preceded by 18 spaces.

Ageline (AARP) filter

ACM Digital Library
(Association for 
Computing 
Machinery)

Users with subscription access to this Web site can 
save multiple records to a BINDER. Once saved, 
you can export the records in an EndNote format.

Non-subscribers can download one record at a time: 

1. Create a search.

2. Click on an article.

3. Scroll half-way down the page and select 
EndNote under Display Formats.

Limitations:

Since only plain text files can be imported into 
EndNote, you cannot import images, graphics, etc.

Before importing, you may need to edit the file to 
insert a comma after corporate author names. 
Otherwise, EndNote will not be able to distinguish 
corporate authors from personal authors.

EndNote Import

CAS SciFinder Save references in the “Tagged Format” (*.txt). SciFinder (CAS) filter

CSA 
(formerly Cambridge 
Scientific Abstracts)

From the CSA search results screen, click Save/
Print/Email. On the “Save/Print/Email” screen, 
select:

Record Format: Full Record
Save File Format: PC

Click Save. Your Web browser asks where to save 
the file. If your Web browser lets you save in 
different file formats, make sure you save as a “Text 
Only” (*.txt) file.

Various filters for CSA 
databases are 
provided in the 
EndNote Filters 
folder.
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Dialog Set your communication software's option to 
capture text. Use Dialog's Format 5 with "tag" 
appended to the TYPE command -- type "s1/5/1-20 
tag". 

You must download data in Format 5. If Format 5 is 
not available, try the “full” format, which is 
sometimes the same as Format 5. For questions 
concerning Dialog’s many formats, please contact 
Dialog's tech support.

Various Dialog filters 
are provided in the 
EndNote Filters 
folder.

DIMDI Use the DLOAD command with report D1 
(e.g. DLOAD REPORT=D1).

Various DIMDI filters 
are provided in the 
EndNote Filters 
folder.

EBSCOhost After adding selected references to your folder, click 
“View Folder” or “Folder has items” to see its 
contents. 

On the Folder Content page, click Export. On the 
Export Manager page, select “Generic bibliographic 
management software" to save a file to disk. Click 
Save.

Various EBSCO filters 
are provided in the 
EndNote Filters 
folder.

EDINA Use the “Name” format, where data is tagged with 
words such as “Author” rather than “AU.”

Because there are so many different formats used 
for source data, you may need to manually edit 
source data after importing.

EndNote cannot parse author names that are not 
clearly delimited, such as 
“S Hughes B Reynolds S A Bell & C Gardner.” You 
will need to manually edit author names.

Various EDINA filters 
are available in the 
EndNote Filters 
folder.

Output Formats and Corresponding Import Options
Information Provider Recommended Download Format Import Option
Chapter 6: Importing Reference Data into EndNote 69



Emerald Display the marked list, click “display for download 
(ASCII),” and then save as a plain text file.

The filter provided works for these Emerald 
databases:

Emerald Management Reviews at 
http://www.emeraldinsight.com/revs/

Computer Abstracts International Database at http:/
/www.emeraldinsight.com/caid

International Civil Engineering Abstracts at 
http://www.emeraldinsight.com/icea/

Computer & Communications Security Abstracts at 
http://www.emeraldinsight.com/ccsa/

Current Awareness Abstracts at 
http://www.emeraldinsight.com/caa/

Limitations:

Page numbers are separated by a hyphen with 
spaces on either side of it. You will need to manually 
remove the spaces after importing. 

Emerald filter

InfoTrac 
(Gale)

From the E-Mail Delivery panel at the bottom of the 
marked list window, restrict the contents to 
“citation;” do not choose “full article.”

Limitations:

Records often have extraneous information in the 
title field, which must be removed manually after 
importing.

InfoTrac (GALE) filter

INIST 1.  Click the Enregistrer button.

2.  Select the records you wish to download. 

3.  Under “Quels champs?” choose "Tous les 
champs."

4.  Under “Incluez” choose "Numéro de notice et 
nom de la base de données" and "Libellés abrégés."

5.  Click the Sauvegarde de notices button.

Various INIST filters 
are provided in the 
EndNote Filters 
folder.

INNOPAC Save references in the “EndNote” format. EndNote Import

Knowledge Finder Place document in the Save file, and select the 
document. Choose Export Selected Documents 
from the File menu.

Various Knowledge 
Finder filters are 
provided in the 
EndNote Filters 
folder.

Output Formats and Corresponding Import Options
Information Provider Recommended Download Format Import Option
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Medscape After selecting the desired records and adding them 
to your clipboard, click the Save or Email Clipboard 
link. Save or e-mail your clipboard in PC or Mac 
MEDLARS format as a plain text (*.txt) file.

MEDLINE 
(Medscape) filter

NERAC Save your file as plain text (*.txt). NERAC

OCLC FirstSearch 1. Mark the records you wish to download.

2. In the navigation pane, click Export.

3. Click the radio button next to “The marked 
records” or “A range of records.”

4. Click the radio button next to “EndNote.”

5. Click Export and save to a Text file.

Various OCLC filters 
are provided in the 
EndNote Filters 
folder.

Ovid 1. After selecting the references you wish to 
download, click Results Manager. 

2. Choose the following options:

Fields:  Complete Reference

Citation Format:  Reprint/Medlars (or     Direct 
Export, if available)

3. Click the Email or Save button. 

4. Save the file as plain text (*.txt).

The appropriate Ovid 
filter will be selected 
automatically when 
using the Direct 
Export option. If you 
are using Ovid's 
multiple database 
searching, you must 
select the Direct 
Export citation format.

ProQuest 1. Select the desired references, and then click the 
My Research Summary tab.

2. Click the “Documents and Bibliography” tab.

3. Choose “Export,” then either “Export directly to 
ProCite, EndNote or Reference Manager,” or 
“Download in a format compatible with ProCite, 
EndNote, Reference Manager and RefWorks.” If you 
choose the former, make sure your data is displayed 
in a tagged format before saving as a text file.

ProQuest filter

PsycINFO http://www.apa.org/psycinfo

After marking the records you wish to download, 
choose Full PsycINFO Record then click the Display 
Marked Records button. Select the text, then copy 
and paste it into a text editor, saving the file as plain 
text (*.txt).

Use the PsycINFO 
(APA) filter.

Output Formats and Corresponding Import Options
Information Provider Recommended Download Format Import Option
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PubMed  For detailed instructions on how to search the 
PubMed database, see “Importing References 
from PubMed” in EndNote Help. 

You can also get detailed instructions from our 
EndNote Support site at:

http://www.endnote.com/support/faqs/Import/
faq1.asp

 To search the PubMed database, go to:

http://www.ncbi.nlm.nih.gov/pubmed

PubMed (NLM) filter 

SilverPlatter 
WebSPIRS

1. Once you've obtained your search results, click 
Save. 

2. Select the following “Save Records” options:

Which fields?: All fields

Include: Record number and database name

Field labels: Short labels.

3. Click the Save Records button. 

4. Use your Web browser to save the page as "Text 
Only" (do not save in HTML format).

Various SilverPlatter 
filters are provided in 
the EndNote Filters 
folder.

STN Set your communication software’s options to 
capture text to a file. Type the command “Display 
All”.

Various STN filters 
are provided in the 
EndNote Filters 
folder.

UnCover (Ingenta) Using your email software, save references emailed 
to you as a "Plain Text" or "Text Only" file.

UnCover (INGENTA)

VHL
(Virtual Health 
Library)

1. After selecting the desired references, scroll to 
the bottom of the page, and then click Your 
collection (or “Su selleccíon”).

2. Cancel the print dialog, and then save the screen 
as a plain text file.

Various VHL filters 
are provided in the 
EndNote Filters 
folder.

Output Formats and Corresponding Import Options
Information Provider Recommended Download Format Import Option
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Direct Export 
from Web 
Pages

Certain Web sites contain a download button that will send your 
search results directly to EndNote, pick the correct import filter, 
and start the import process automatically. 

Start by opening the EndNote library into which the data should 
be imported. This “direct export” or “direct download” method 
does away with the additional steps of saving the references to a 
text file, and then importing that file with the appropriate filter. 

The systems listed below provide a direct export of references 
into EndNote. A detailed table of instructions can be found in 
”Direct Export Providers” in EndNote Help. The list keeps 

All Databases
Web of Science

Go to the All Databases or Web of Science Search 
page and perform a search. 

1. From the Results page, select the records that 
you wish to export to EndNote.

2. Go to Output Records and select the option to 
output Full Record in step 2.

3. Select Save to Export to EndNote, RefMan, 
ProCite.

4. On the Processing page, click the Export 
button.

You may also choose Save to Tab-delimited to save 
the references to a text file, and then import them 
into EndNote.

ISI-CE filter

Wilson 1. Click Print Email Save. 

2. Click Export to Bibliographic Software. 

3. Choose The EndNote Filter, and then click 
Export.

4. Save to a text file.

WilsonWeb filter

WorldCat 
(OCLC FirstSearch)

1. Mark those references to be saved, and then click 
Export.

2. Choose Text File. 

3. Click Export.

WorldCat (OCLC) 
filter

Output Formats and Corresponding Import Options
Information Provider Recommended Download Format Import Option
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growing, so contact your information provider to find out whether 
they participate!

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Importing Reference Data” to learn about import options and 
about importing references from other bibliographic software 
programs.

 “Filters” to learn how to create or modify filters that map 
downloaded references to corresponding fields in EndNote.

ALEPH Los Alamos National Laboratory
American Psychological 
Association, PsycInfo Online

MicroPatent

Bibliotech.dk Nature
BioMedCentral Nerac
BioOne NISC
Blackwell Synergy OCLC
BMJ OhioLink
Buffalo University OVID
CABI-Direct OVID SilverPlatter
Canadian Journal of 
Communication

Oxford Press Journals

CCLR Pacific Northwest Labs
Delphion Patent Cafe
EBSCO PILOTS
El Engineering PNAS Online
Elsevier ProQuest
EMBASE RLG
ERIC Science Magazine
ESDS Government Scopus
Google Scholar St. John of God, Ireland
HAPI Stanford University's Highwire Press
IEEE Telemed
JAMA Thieme
JISC Web of Science
JSTOR WebFeat
Karger Publishing WilsonWeb
74 Chapter 6: Importing Reference Data into EndNote



 “Direct Export Formats and Import Formats” to learn about 
tables of instruction for importing reference data from various 
online systems.
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Chapter 7: Searching an EndNote Library and 
Saving it as a Smart Group

In this part of the guided tour you will learn how to:

 Search an EndNote library for a set of related references.

 Save the search strategy to create a smart group that is 
dynamically updated each time you enter or edit a reference. 

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X4 as shown in “Start EndNote” on page 
27.

Search for a 
Set of 
References

Let us assume that you want to generate a list of all references 
found in the sample library that are about extinction and that were 
published from 2000 to 2010.

To search for references:
1. Make sure that the All References group is displayed.

2. In the Tab pane, display the Search tab.

3. The Search tab remembers the last search you entered. To 
clear it, use the Options button to select Restore Default.

4. On the first search line:

a. In the first drop-down list, the Field list, select Any Field. 
This means that EndNote will search all fields. 

b. In the next drop-down list, the Comparison list, the 
Contains comparison operator means that EndNote will 
search for the string of text anywhere in the field.

c. Type “extinct” as the first search term.

Next, set up the search to find references dated from 2000 to 
2010. 
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5. From the Field list in the second search line, choose Year; 
from the Comparison list, choose Is greater than or equal to; 
and type 2000 as the search term for the second search line.

6. If you do not have a third search line available, click the plus 
sign button next to the last search line to insert another line. 
You can also click and drag the top of the pane to view more 
of the Search tab.

7. From the Field list in the third search line, choose Year; from 
the Comparison list, choose Is less than or equal to; and type 
2010 as the search term. 

8. Notice the “And, Or, Not” logical operator list at the beginning 
of each search line. Select the “And” logical operator 
between the three search lines. 

Your Search tab should look like this:

This search will find all references containing the text 
“extinct” that also were published between 2000 and 2010. 

Notice that the following check boxes are not selected for this 
search:

Match Case: This option would limit our search to “extinct” in 
lowercase. If it were found capitalized at the beginning of a 
sentence, or all uppercase, it would not match the search.

Match Words: This option would limit matches to full words, 
with no truncation. The word “extinction” would not match our 
search. 
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9. Click the Search button to begin the search. In a moment, 
EndNote displays the search results.

The status area at the bottom of the Library window should read, 
“Showing 5 of 5 references in Group.”

Notice in the Groups pane that these search results are 
automatically retained in a Search Results group. This makes it 
easy to display other sets of references, but still go back and 
display your most recent search results. This temporary Search 
Results group will be replaced the next time you run a search on 
the library. When you close the library, this group is removed.

As you enter additional references into your library, you may 
want to keep track of the references that meet this search 
criteria. An easy way to do this is with a smart group as described 
next.

Create a Smart 
Group

You could create a custom group, and then drag your search 
results to the group, but as you entered new references into your 
library, you would need to manually keep updating the custom 
group. Instead, create a smart group that updates automatically.

The Search tab should still display the search strategy to find 
“extinct” and the publication years 2000 to 2010.
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To use the search strategy to create a smart group:
1. Click the Options button and select Convert to Smart Group.

A Converted Search smart group is created under the first 
custom group set, Paleontology.

2. Type “Extinct” for the Converted Search title, and press 
ENTER.

If you have already clicked away from the editable title, you 
can right-click Converted Search and choose Rename 
Group.

Each time a reference is added to the library or later edited, the 
smart group will update as needed.

To show all references again in the library window, click the All 
References group. 

Create a 
Combo Group

Let us assume that you want to combine all your custom groups 
and smart groups under the Paleontology group set in order to 
create a combination group.

To create a combination group:
1. In the Groups pane, click on any of the groups in the Pale-

ontology group set.

2. From the Groups menu, choose Create from Groups.
3. In the Group Name field, type “Paleontology Combo Group.” 
4. Go to the Include References In fields. In the first field, 

choose Earth Studies from the Paleontology group set.
5. In the second Include Reference field, choose Exocene, and 

then select the Or Boolean operator.
6. Choose Excavation from the third list, and then select the Or 

Booelan operator.
7. Choose Extinct from the fourth list, and then select the Or 

operator.
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8. Lastly, choose Fossils from the fourth list, but then select 
the Not operator.

9. Click the Create button to save your changes. Your combo 
group should appear in the Groups pane.

Your combined group should contain 48 references from the 
following custom groups and smart groups.

 Earth Studies

 Exocene

 Excavation

 Extinct

Notice your combination group does not contain any references 
from the Fossils group because we used the Not operator to 
exclude references from this group. Moreover, it does not contain 
any references from the other four groups that also appear in the 
Fossils group. That is, duplicates are excluded from the 
combination group.

NOTE: If you delete a reference from a combined group, EndNote 
removes that reference from the custom and/or smart group from which 
it originally came. Keep in mind that references deleted from a custom 
group are removed from the group, and from the combo group, but not 
from the All References list. References deleted from a smart group are 
removed from the smart group, the combo group, and the All 
References list, and moved to the Trash group.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Searching and Sorting in EndNote” to learn more about 
searching the EndNote library and saving references in 
groups.

 “Using Groups” to learn more about creating and managing 
groups.
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Chapter 8: Using EndNote While Writing a 
Paper with Microsoft Word

NOTE: Continue with this part of the tour only if you use Microsoft Word 
2003, 2007,or 2010. If you use a different word processor or if you have 
an older version of Word, see “Cite While You Write Commands 
(OpenOffice.org Writer)” or “RTF Files/Scanning and Formatting” in 
EndNote Help to learn how to cite EndNote references and create 
bibliographies in your papers. 

EndNote’s Cite While You Write feature inserts EndNote 
commands into Word’s Tools menu in Word 2003 or on an 
EndNote tab in Word 2007 and 2010to give you direct access to 
your references while writing in Microsoft Word. The Cite While 
You Write commands enable EndNote to do bibliographic 
formatting to the document that is currently open in Word.

In this part of the guided tour, you will learn how to:

 Insert EndNote bibliographic citations into your paper and 
create a bibliography.

 Edit citations to suppress author names and add cited pages.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X4.enl as show in “Start EndNote” on 
page 27.

EndNote will look for matching references in the currently open 
library. While EndNote can start and open your default library 
when needed by Word, opening the library first assures you that 
you are citing references from the appropriate library.

Open a 
Microsoft 
Word 
Document

For this tour, start Microsoft Word and open a new document. 

While we are not using one for this tour, EndNote does include 
manuscript templates that make it easy to set up your paper for 
electronic submission to a publisher. When you use one of these 
templates to start your paper, many formatting issues are already 
set up for your target publication, such as proper margins, 
headings, pagination, line spacing, title page, font type and size, 
etc. 

For more information about using manuscript templates, see 
“Creating a Word Document Based on a Template” in EndNote 
Help.
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Cite EndNote 
References

You are going to start entering text and citations. For this tour, 
you are going to enter minimal information.

To start writing your paper and inserting citations:

1. Enter text as though you were writing your paper:

The fossil in question was generally 
regarded to be the 220 million year-old 
remains of tyrannosaurus. Several years ago, 
however, Morehouse overturned this hypothesis 
with the discovery of yet another species.

Now you are ready to insert a citation. 

2. Word 2003: From the Tools menu, go to the EndNote X4 
submenu and then click Find Citation(s). 

Word 2007 and 2010: On the EndNote tab, in the Citations 
group, click the Insert Citation icon.

3. The Find & Insert My References dialog appears. Type the 
author name “Morehouse” in the text box, and then click Find.

EndNote lists the matching references. 

4. Click Insert to insert the selected reference as a citation. 
There may be a delay the first time Word communicates with 
EndNote for the document.
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EndNote not only inserts a citation, but Instant Formatting 
formats the citation in the currently selected style and adds it 
to a formatted bibliography at the end of the paper. 

EndNote automatically creates a link from the citation to the 
bibliography. If you have multiple bibliographies (for example, 
one at the end of each chapter and one at the end of the 
document), you can link in-text citations to the reference list at 
the end of each section and/or chapter. See“Select a 
Bibliographic Style” on page 86 for information on how to turn 
this feature on and off.

5. Add more text to the paper:

It is now the undisputed progeny of the 
species at hand.

6. Word 2003: From the Tools menu, go to the EndNote X4 
submenu, and then click Find Citation(s). 

Word 2007 and 2010: On the EndNote tab, in the Citations 
group, click the Insert Citation icon.

7. Type the date “1987” into the text box, and then click Find. 
EndNote searches all fields and lists the matching 
references.
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8. Select the reference by the author Turnhouse, and then click 
Insert.

EndNote inserts the citation, and Cite While You Write 
technology formats it and adds it to the bibliography at the 
end of the paper. 

Your document text should look similar to this:

9. Assume that you have finished inserting citations in your 
paper.

Keep your document open in order to select a bibliographic style 
to continue the tour in “Select a Bibliographic Style” on page 86.

NOTE: You can also insert citations in footnotes. First, use the 
appropriate Word command to create the footnote. Then, insert the 
EndNote citation in the footnote. Word controls the placement and 
numbering of the footnote, and EndNote formats the citation based on 
the current style. You must select a style that formats footnotes; for 
example, Chicago 15th A.

Select a 
Bibliographic 
Style

You can format your citations and bibliography as many times as 
you like, changing the output style and various other layout 
settings each time.

To select the bibliographic style used for formatting:
1. Word 2003: From Word’s Tools menu, go to the EndNote X4 

submenu and choose Format Bibliography.

Word 2007 and 2010: On the EndNote tab, in the 
Bibliography group, click the bottom corner arrow.
86 Chapter 8: Using EndNote While Writing a Paper with Microsoft Word



A Format Bibliography dialog appears where you can select 
a bibliographic style. 

You can also turn off underlining and linked in-text citations 
by clearing the two check boxes. 

Styles contain instructions for how EndNote will format 
citations and the bibliography. Some styles sequentially 
number citations, and then insert a numbered reference list 
at the end of the paper. Other styles insert Author-Date 
citations.

As you can see, there are other formatting options available 
here; you can make changes that override the settings in the 
current output style.

2. For this example, click the Browse button next to “With output 
style” to display the list of output styles supplied with 
EndNote.

3. Select the APA 6th style, and then click OK. You can sort the 
list of styles by Name or by Category by clicking on a column 
header.

4. Click OK to leave the Format Bibliography dialog.

EndNote automatically updates the existing citations and 
regenerates the bibliography in the APA style. 

Your document text should look similar to this:
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NOTE: In the future, if you need to make changes to the paper such as 
adding or deleting citations or text, just do the necessary updates in 
your paper. If you want to change the output style or bibliography layout 
settings, choose the Format Bibliography command again. EndNote will 
reformat the in-text citations and generate a new bibliography based on 
your changes.

NOTE: More than 4,500 styles are available. To see the list of styles 
currently installed, choose Output Styles from the Edit menu in 
EndNote and then choose Open Style Manager. The Style Manager 
includes a Get More on the Web button to easily locate and download 
individual styles. Or, you can install entire categories of styles with the 
EndNote installation program.

Edit a Citation If you directly edit a citation or the bibliography, the changes will 
be lost when you Format Bibliography again because EndNote 
reformats according to the rules of the selected output style. To 
make and retain changes to all citations and/or the bibliography, 
modify the output style. However, if you want to make a change 
to an individual citation, use the Edit Citation command as 
described below.

For some bibliographic styles, the majority of references are 
cited in an “Author, Date” format; but if the author’s name is 
mentioned within the paragraph text, the style dictates that the 
name not be repeated in the citation. In our example, we mention 
Morehouse within the text of the paper, so we will remove the 
author’s name from the citation. We also want to add a page 
reference to this particular citation.

To edit an individual citation:
1. Click anywhere on the Morehouse citation.
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2. Word 2003: From the Tools menu, go to the EndNote X4 
submenu, and then click Edit & Manage Citation(s). 

Word 2007 and 2010: On the EndNote tab, in the Citations 
group, click Edit & Manage Citation(s).

3. Select the Exclude Author check box.

4. In the Pages field, type “34-35”.

NOTE: Typing cited page numbers in this box does not guarantee that 
they will appear in your citation. You must use an output style that lists 
the Cited Pages field in the Citation template. You can edit any style to 
include this special field.

5. Click OK to update the citation in your paper.

Your document text should look similar to this:
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As you are working, remember to often Save your document. You 
can continue adding text and bibliographic citations to the paper, 
and EndNote will continue adding to the list of references.

This completes the guided tour. You can close Microsoft Word.

To close the EndNote program, go to the File menu in EndNote 
and choose Exit.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Microsoft Word/Cite While You Write” to learn about he 
process of citing references and figures and creating 
bibliographies.

 “Bibliographic Styles” to learn about and install output styles.

 More than 4,500 styles are available, although a typical 
EndNote installation includes only the 100 most popular 
styles in EndNote’s Styles folder. To see a list of them 
organized by discipline, choose Output Styles from the Edit 
menu and select the Style Manager.
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